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1 Welcome
Welcome to PicoDiagnostics, the automotive fault finding software for your PicoScope
oscilloscope. 

With a PicoScope, PicoDiagnostics turns your PC into an automotive diagnostics tool. The
program includes a range of built-in tests that are easy to operate, even if you haven't used
them before.

If you need to go beyond the built-in tests, an additional program is available: PicoScope
Automotive. This software will have been downloaded and installed along with PicoDiagnostics.
This gives you all the features of an advanced oscilloscope and can be used to diagnose almost
any electrical component in any vehicle.

http://www.picoauto.com/software.html
http://www.picoauto.com/software.html
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2 Introduction
PicoDiagnostics supports the PicoScope 3000 Automotive and 4000 Automotive Series
diagnostic oscilloscopes. 

· Contact information 
· How to use this manual 

How to use PicoDiagnostics

· Getting started: see Using PicoDiagnostics for the first time. 
· For further information: see descriptions of Menus.
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2.1 Legal statement
Grant of license. The material contained in this release is licensed, not sold. Pico Technology
Limited ('Pico') grants a license to the person who installs this software, subject to the
conditions listed below.

Access. The licensee agrees to allow access to this software only to persons who have been
informed of and agree to abide by these conditions.

Usage. The software in this release is for use only with Pico products or with data collected
using Pico products.

Copyright. Pico claims the copyright of, and retains the rights to, all material (software,
documents etc.) contained in this release.

Liability. Pico and its agents shall not be liable for any loss or damage, howsoever caused,
related to the use of Pico Technology equipment or software, unless excluded by statute.

Fitness for purpose. No two applications are the same, so Pico cannot guarantee that its
equipment or software is suitable for a given application. It is therefore the user's responsibility
to make sure the product is suitable for the user's application.

Mission-critical applications. Because the software runs on a computer that may be running
other software products, and may be subject to interference from these other products, this
license specifically excludes usage in 'mission-critical' applications, for example life-support
systems.

Viruses. This software was continuously monitored for viruses during production. However, the
user is responsible for virus checking the software once it is installed.

Support. No software is ever error-free, but if you are dissatisfied with the performance of this
software, please contact our technical support staff.

2.2 Upgrades
We provide upgrades, free of charge, from our website at www.picoauto.com. We reserve the
right to charge for updates or replacements sent out on physical media.

2.3 Trademarks
Windows is a registered trademark of Microsoft Corporation. Pico Technology, PicoScope and
PicoDiagnostics are internationally registered trademarks.

2.4 How to use this manual
This manual is divided into topics. For example, the topic you are now reading is called "How to
use this manual". Notice the tabs on the left labeled Contents, Index and Search. If you click
the Contents tab, you will see a table of contents listing all the topics in the manual. Double-
click any one of these topics to read it. Use the Index and Search tabs if you want to look up
a particular word or phrase.

Also, look out for the Forward and Back buttons. These allow you to retrace your steps in the
trail of topics that you have read since opening the manual.

https://www.picoauto.com/tech-support
https://www.picoauto.com
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While you are using PicoDiagnostics, you will often see Help buttons. Clicking these will take
you to the relevant topic in this manual.

For your first introduction to PicoDiagnostics, we suggest that you start with the topic 'Using
PicoDiagnostics for the first time'.

2.5 System requirements
PicoDiagnostics runs on Microsoft Windows. For supported versions, see the installation notes
on picoauto.com/downloads. 

https://www.picoauto.com/downloads
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2.6 Using PicoDiagnostics for the first time
We have designed PicoDiagnostics to be as easy as possible to use, even for newcomers to
automotive diagnostics. Once you have followed the introductory steps listed below, we hope
you soon feel like an expert.

1. 

Connect your PicoScope oscilloscope to a USB port on your computer.
Windows will recognize it and make the necessary changes to allow your
computer to work with it. Wait until Windows tells you that the device is
ready to use. 

2. Click the new PicoDiagnostics icon on your Windows desktop. 

3. Click the button for the test you wish to perform.

4. 
Follow the on-screen Setup Wizards or instructions on connecting your
scope and running the test.
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3 Menus
Menus are the quickest way to get to the main features in PicoDiagnostics. The Menu bar is
always present at the top of the PicoDiagnostics main window, just below the window's title
bar. You can click any of the menu items, or press the Alt key and then navigate to the menu
using the cursor keys, or press the Alt key followed by the underlined letter in one of the menu
items. 

The list of items in the menu bar may vary depending on which test you are running.

3.1 File menu
Click File on the Menu bar.

Load. Allows you to load a test from disk to review the result. Loading a test result
from disk will clear any captured data and results.

Save. Some tests allow you to save test data to disk.

Print. Opens a standard Windows print dialog, which allows you to choose a printer, set
printing options and then print the selected view.

Print Preview. Opens the Print Preview window, which allows you to preview the
report before printing it with the Print command.

Preferences. Opens up the User Details dialog.

Exit. Close PicoDiagnostics without saving any data.



Menus

11Copyright © 2009-2020 Pico Technology Ltd. All rights reserved.pd.en-19

PicoD iagnostics  User 's  Guide

3.1.1 Preferences dialog

This dialog appears when you select Preferences on the File menu. In this dialog, you can
enter details about your company, including your logo in the User Details tab. This information
will be included and displayed in the report you print for your records and to provide to your
customer. You can also set your preferred measurement units and language in the Regional
and Language tab.

Enter all the values you want.

Click OK to close the dialog and save the changes.

Click Cancel to close the dialog and discard the changes.

3.2 View menu
Click View on the Menu bar.

Details. Edit the vehicle details and notes.
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3.2.1 Details dialog

This dialog appears when you select Details on the View menu. It allows you to enter details
about the vehicle you are testing. There is also a space for entering Notes about the test.

3.3 Tests menu
Enter topic text here. Click Tests on the Menu bar.

This menu lists all the tests available. Click one of the tests to proceed.

3.4 Options menu
The Options menu changes depending upon which test you are carrying out at the time.
Please see below for links to the test options you require:

· Cylinder balance options
· Compression test options
· Battery test options
· Propshaft balancing options
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3.5 Help menu
Click Help on the Menu bar.

These are the standard Windows options for access to the help file for the relevant test.

Note: The NVH test has an additional help file, which you can access by clicking Help > NVH
Diagnostic Help... F1 within the NVH test.



Tests

14Copyright © 2009-2020 Pico Technology Ltd. All rights reserved.pd.en-19

PicoD iagnostics  User 's  Guide

4 Tests
PicoDiagnostics is a collection of specific automotive tests. They are all designed to be easy to
use, even if you have little or no experience of automotive diagnostics.

These tests are available with this installation of PicoDiagnostics:

· Cylinder Balance
· Compression Test
· Battery Test
· Propshaft Balancing

4.1 Cylinder Balance
The Cylinder Balance test measures how much each cylinder contributes to the engine's total
power output. There are a number of things that can cause a cylinder to contribute less than
the other cylinders. These include but are not limited to:

· low compression
· faulty injector
· faulty spark plug.

A slightly uneven balance does not necessarily mean that there is a fault in the engine. During
warm-up, most engines run slightly unevenly. Deposits and engine wear may also have an
effect on the engine's performance.

To use the Cylinder Balance test, start PicoDiagnostics and set the test conditions.

4.1.1 Test conditions

The following test conditions must be met before running the test:

· The engine must be at normal operating temperature. You can confirm this by waiting until
the cooling fan has been activated twice, and referencing the temperature gauge on the
dashboard.

· The engine must be switched off before you connect the oscilloscope.

4.1.2 Options

This dialog appears when you click the Options menu on the main Menu bar while in the
Cylinder Balance test. It allows you to decide whether the cylinder balance wizard appears
before running the test.

 

4.1.3 Running the test

To start the test click Start. If the test successfully starts, a new window with a progress
indicator will briefly appear on the screen. The data is now being analyzed and shown in real
time on screen with the results appearing in the bar graph as shown below.
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The result
If the test could not produce a result see: Failed cylinder balance.

You can stop the test at any time by simply clicking Stop. It is possible to then scan through
the results by clicking Play. The results are always scaled to show the highest cylinder at
1.00.

4.1.4 Controls

Right-click the cylinder balance bar graph to bring up a menu with display options. You can use
this menu to access more information concerning the test and its result.

Variation
Displays the variation in contribution for
each cylinder as an overlaid blue bar.
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Misfire
Displays suspected misfires as a separate
bar for each cylinder.

Signal
Not required for basic testing

Brings up a second graph, the signal
graph.
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4.1.5 Signal graph

The signal graph displays the captured data as engine speed or cylinder contribution.

Zooming
You can use the mouse to zoom in on the data. Use the context menu (right-click) to zoom out
again.

Signal graph context menu
Right-click the graph to bring up a menu with display options. You can use this menu to access
more information concerning the test and its result.

Zoom out
This zooms out to display the full data set.

View
You can choose to view the engine speed, the Cylinder Contribution, or view the Trigger
Signal with Speed Signal.
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4.1.6 Failed test

If the test could not produce a result, make sure that:

· the connection to the battery is good
· the tension of the alternator belt is adequate.

It may also help if you switch the headlights on full beam and switch on other electrical
loads, such as the rear windscreen heater and fog lights.

There are some engines for which the test has difficulties producing a result. These
include:

· engines with more than 8 cylinders
· some engines with dual-mass flywheels
· engines with inertial dampers
· some engines with smart alternators
· vehicles with xenon lights

If there is still a problem
If you have checked the points mentioned above and the software still cannot produce a
result, we would like you to send us a copy of the of the failed test data. Please enter as
much information as possible about the vehicle tested. This is done via the Details dialog.
Save the test to a file using the File > Save menu and email the file to us on
support@picotech.com.

mailto:support@picotech.com
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4.2 Compression Test
The Compression Test is meant to be a first check. If the compression looks good, you can
quickly move on and investigate other components which might be the cause of the fault. If
the test detects a low cylinder, you should perform a manual compression test to verify the
results and to work out which cylinder is low.

 Compression test - before starting the test

There are two types of compression test:

· Relative compression - requires no pressure transducer, only a connection to the
battery. 

· Absolute compression - requires a connection to the battery and a pressure transducer
connected to a spark plug port. 

4.2.1 Test conditions

The following test conditions must be met before you can run the test:

· The engine must be at normal operating temperature. You can confirm this by waiting until
the cooling fan has been activated twice, and referencing the temperature gauge on the
dashboard.

· The engine must be off before you connect the oscilloscope.
· The cranking speed must be normal (the battery must be charged).
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4.2.2 Connecting the PicoScope

Connect your scope to a free USB port on your PC with the USB cable.

Connect one of the general BNC test leads to Channel A on your scope. Connect a large red
crocodile clip to the red end of the lead and a large black crocodile clip to the black end of the
lead. Connect the red clip to the battery positive (+) terminal and the black clip to the battery
negative (-) terminal.

Connecting the pressure transducer (absolute compression test only)
Remove the spark plug from Cylinder 1. Fit a compression hose into the empty spark plug
socket and attach it to the pressure transducer's inlet port (as shown in the picture below).
Then connect a BNC-to-BNC lead from the pressure transducer to Channel B on your scope.

Disabling the engine
The compression test can only be performed when the engine is cranking, so it must be
prevented from starting. You can do this by removing the engine management relay from the
fuse box or disabling the injectors.

4.2.3 Test setup

The compression test should be performed according to the vehicle manufacturer's
specification.

· If you are using the pressure transducer, click Pressure.
· Next, click the numbered button corresponding to the number of cylinders in the engine.
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4.2.4 Options

This dialog appears when you click either the Options menu on the main menu bar in the
Compression Test, or the Pressure button located at the bottom of the screen. It allows you
to set special options before running the test. These options apply only to the absolute
compression test, and not to the relative compression test.

Compensate Check to use the Cylinder Volume, Compression Ratio and
Sensor Volume parameters. Leave unchecked to ignore these
values.

Cylinder Volume (l) The volume of the cylinder in liters.

Compression Ratio (X:1) The compression ratio of the cylinder. For example, if the
compression ratio is 11:1, enter 11.

Sensor Volume (l) The volume of the pressure sensor in liters. This information
should be available from the manufacturer of the sensor. If in
doubt, do not alter the value in this box.

Engine Capacity The size in cubic centimeters (cc) of the engine under test.

Use Pressure Sensor Indicates whether a WPS500X pressure transducer is being used
during the test.
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4.2.5 Running the test

· To start the test, click Start.
· A new window with a progress indicator and instructions will appear on the screen. Wait until

the message in the window is "Crank engine".
· With the throttle wide open (accelerator pedal fully depressed), crank the engine until the

progress indicator reaches 100%.

The data is now analyzed and the result appears in a bar graph, as in one of the examples
below:

Compression test result -
without pressure sensor

(relative mode)

In relative compression mode, the result is
always scaled to show the highest cylinder at
100%. The bars are ordered according to the
engine's firing order. The cylinders are named
A, B, C and so on, because with only a
connection to the battery the software has
no way of knowing which cylinder is number
one. This may cause the result to be shifted if
you run the test on the same engine more
than once.

Compression test result -
with pressure sensor

(absolute mode)

In absolute compression mode,
PicoDiagnostics shows the true compression in
each cylinder. As in relative compression
mode, the bars are named A, B, C and so on.

The result
If the test could not produce a result, see Failed test.
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4.2.6 Failed test

If the test could not produce a result, make sure that:

· the connection to the battery is good
· there is not a battery charger connected to the vehicle's electrical system.

If there is still a problem 
If you have checked the points mentioned above and the software still can't produce a
result, we would like you to send us a copy of the of the failed test data. Please enter
as much information as possible about the vehicle tested. This is done using the Details
dialog. Save the test to a file using the File | Save menu and email the file to us at
support@picotech.com.

Note: Some engines fitted with a flat-plane crank can give spurious low compression
readings.

mailto:support@picotech.com
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4.3 Battery Test
To use the battery test, start PicoDiagnostics and click Battery Test.

Tip: If the battery has been recently charged, there is a risk of “surface charge” affecting the
state-of-charge results. To eliminate the surface charge, switch the lights on full beam for
about 2 minutes, switch them off, and then wait for about 2 minutes before performing the
test. If you are only measuring cold cranking amps (CCA), you can ignore this precaution.

Note: It is important not to confuse the industry-standard method of battery testing (SAE EN
DIN) with the PicoDiagnostics battery test, even though the results stated are in the same
units of CCA. The CCA rating of any battery is a figure arrived at by design. Therefore, any
battery test result (measured in CCA) obtained by running a PicoDiagnostics battery test
can only ever be an instantaneous and calculated estimate based on the measured
resistance of the battery, with the advantage of being able to safely draw current from the
battery where other tests don't. 

Follow the instructions below to connect your PicoScope to the vehicle and run the test.

· Connect the PicoScope
· Set any special test options
· Run the test
· If the result is blank
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4.3.1 Connections

Connect the PicoScope
Connect the PicoScope to a free USB port on your PC using the USB cable.

Channel A: Battery voltage
Connect one of the general test BNC cables to Channel A on your PicoScope. On the other
end, connect a large red crocodile clip to the red lead and a large black crocodile clip to the
black lead. Connect the red clip to the battery positive either on the battery or in the fuse box.
Connect the black clip to a secure earth (ground) point as shown in the picture below.

Channel B: Starter motor current
Connect a high amp current clamp to Channel B on the PicoScope. Place the current clamp so
that it is positioned around the positive cables which are connected to the positive battery
terminal. More importantly make sure the current clamp is positioned around the starter motor
positive or negative cable in order to record the cranking current from the starter.

If you have a 4-channel scope then you can run the optional extended drop test.

Additional connections for extended drop test

In addition to connecting Channel A and B as described above, Channel C and D must also
be connected as follows:

Channel C: Starter motor positive terminal
Using a BNC to 4 mm lead, connect the red 4 mm plug to the positive terminal of the starter
motor using the appropriate clip / connector. This is the terminal that the main positive cable
from the battery connects to.

Channel D: Starter motor negative terminal
Using a BNC to 4 mm lead, connect the red 4 mm plug to the negative terminal of the starter
motor using the appropriate clip / connector. 

Note: Most modern vehicles don’t have earth cables to the starter motor. In this case connect
to one of the mounting bolts by which the starter motor is attached to the engine or gearbox
bell housing, as the starter will earth through to chassis and/or battery.

This will enable PicoDiagnostics to separate the cable resistance from the starter motor
resistance.

All connections must be clean and free from oil, grease and dirt to ensure the readings are
accurate.
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4.3.2 Setup

First, click either 12 V or 24 V depending on the voltage of your electrical system.

Tip: If you have a 24 V system with two 12 V batteries, test each battery separately.
Otherwise one good battery could hide a fault in the other battery.

Next, set the Type of battery to match the battery you wish to test.

Set the Temperature to the local ambient air temperature in °C or °F depending on your
settings in the Preferences dialog.

The battery capacity in cold cranking amperes (CCA) should now be entered, along with its
standard (CCA Unit). 

Now, set the Battery Test options.
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4.3.3 Options

This dialog appears when you click the Options menu on the main menu bar while the Battery
Test is selected. Here you can:

· Enable the Extended drop test options
· Adjust the Capture time of the test

· Click OK to confirm
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4.3.4 Running the test

Click Start.

Note: Because the engine is not drawing any current at this stage, the program will draw a
horizontal line showing zero amps of current. If this line is not at zero amps, the current clamp
may need to be adjusted. Press the "Zero" button or turn the "Zero" dial on the clamp until the
horizontal line is at zero amps.

Start the engine.

While the test is running, the program shows the voltage on Channel A and the current on
Channel B, and a graph is drawn from left to right. The program automatically stops recording
data when it has enough information, so there is no need to click the Stop button unless you
wish to stop the test early.

The program then analyses the data and shows the results in a table, as in the picture below:

If the program reports "Battery has failed the test - refer to help file for advice", see
Interpreting the Results.
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4.3.5 Interpreting the results

The results from the battery test are displayed in a traffic light system. Green is a pass, yellow
is a warning and red is a fail. 

Battery test parameters:

Battery:

Initial voltage Open circuit voltage (OCV) test at initial connection

State of
charge

State of charge (SOC) percentage based on initial voltage

Lowest
voltage

Lowest recorded voltage during cranking

Voltage drop The voltage differential between OCV and lowest recorded voltage

Maximum
current

Maximum recorded inrush current that initiates starter motor/engine rotation

Internal
resistance

The internal resistance of the battery

Capacity The instantaneous CCA is calculated for the industry-standard CCA unit
chosen in Setup and from the measured OCV, lowest recorded voltage,
voltage drop, cranking current, battery resistance, and battery recovery rate
post-cranking. The CCA capacity of the battery under test is also shown as a
percentage of the specified CCA.

Condition Battery condition will be indicated here.
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Starter motor:

Resistance Battery resistance is the lowest voltage divided by the maximum recorded
inrush current.

Charging circuit:

Status Charging percentage based on the battery voltage deviation from a 100%
charged battery.

Voltage Nominal voltage (100% SOC)

Ripple Nominal total deviation for a battery charging at nominal voltage

Current Charging current

Notes:

If the SOC is low, recharge the battery and run the test again.
If the SOC is green, but the CCA are low, check the following, before you replace the battery:

· Battery connections – loose connections will increase the internal resistance.
· Battery fluid levels – if the battery is not a sealed type, check the fluid levels in each cell.

Changing standard CCA unit (SAE, EN or DIN), battery type or temperature, post
capture

While your test results are displayed on-screen, you can select an alternative CCA unit from
the drop down list, and click Analyse. The instantaneous estimated CCA Capacity results will
be recalculated according to the CCA unit you have chosen.

You can also change the battery Type and click Analyse to recalculate the test results.

Adjusting the Temperature value after capture will change the results in real time.
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4.4 Propshaft Balancing
If one or more components has been removed from the transmission system, the propshaft
needs to be balanced. You can do this with the PicoDiagnostics Propshaft Balancing program,
by fitting balancing weights on the differential coupling flange, using off-the-shelf hose clamps
on the propshaft, or attaching a single balancing weight to the propshaft.

4.4.1 Preparing the vehicle

Raise and support the vehicle according to the manufacturer's directions. Remove the two rear
wheels and secure the rotors or drums to the hub assembly. Position the vehicle on mounts in
order to keep the vehicle level and at the same height as if the wheels were fitted.

Remove any balancing weights from the flange stud bolts before you start the balancing
procedure.

4.4.2 Running PicoDiagnostics

The propshaft balancing procedure is divided into four stages:

· Initial Run
· Calibration Runs
· Verification
· Free run

Click Propshaft Balancing:

In the propshaft balancing wizards selection screen, click which test format you would like to
use to complete the propshaft balancing test.

 

The program displays step-by-step instructions in the form of a wizard for both formats of this
test. We recommend that you follow your chosen procedure carefully.
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4.4.2.1 Pinion Flange Trial Balance wizard

The Pinion Flange Trial Balance wizard guides you through the various steps required to
complete the test. These steps cover:

· The connections to the scope
· The mounting of the accelerometer to the vehicle
· How to fit the magnetic mount and optical sensor (if required) to read the propshaft rotation

speed
· The entry of required technical data

Before you begin

· Make sure that the vehicle is properly supported (refer to service information)
· Remove rocks and debris from the tires
· Make sure that all the leads are clear of rotating components
· Disable the ABS and Traction control if equipped
· Turn off the AC and other accessories

Find a suitable shaft speed. Run the engine with the transmission in high gear to highway speed
(65 to 70 mph or 105 to 113 km/h typical). The software captures the RPM when held stable
for more than 3 seconds, or you can click the Edit Manually box and enter the desired shaft
speed.

After you have finished the verification run, the final imbalance is displayed by the software. If
the imbalance exceeds the minimum requirement, the software will suggest that you remove
the rear tires (make sure that the rotors or drums are secured to the hub) and start the test
again.

If you choose to restart the test, remove all the balance weights first. You can click the Initial
Run button to restart the test or the Propshaft Balancing button to go back through the
setup wizard.
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4.4.2.2 Hose Clamp Trial Balance wizard

The Hose Clamp Trial Balance wizard will guide you through the various steps required to
complete the test. These steps cover:

· The connections to the scope
· The mounting of the accelerometer to the vehicle
· How to fit the magnetic mount and optical sensor (if required) to read the propshaft rotation

speed
· The entry of required technical data

Before you begin

· Make sure that the vehicle is properly supported (refer to service information)
· Remove rocks and debris from the tires
· Make sure that all the leads are clear of rotating components
· Disable the ABS and Traction control if equipped
· Turn off the AC and other accessories

Find a suitable shaft speed. Run the engine with the transmission in high gear to highway speed
(65-70 mph typical). The software will capture the RPM when held stable for more than 3
seconds, or you can click the Edit Manually box and enter the desired shaft speed.

After you have finished the verification run, the final imbalance will be displayed by the
software. If the imbalance exceeds the minimum requirement, the software will suggest that
you remove the rear tires (make sure that the rotors or drums are secured to the hub) and
start the test again.

If you wish to attach a single weight, the hose clamps can be removed and replaced with a
single weight as indicated by the software at the location of the blue arrow.
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4.4.2.3 Options

You can find the Options menu under Tools on the main menu bar in the Propshaft Balancing
test.

When you click Options the propshaft balancing wizards selection screen is shown, allowing
you to choose between test formats.



Tests

35Copyright © 2009-2020 Pico Technology Ltd. All rights reserved.pd.en-19

PicoD iagnostics  User 's  Guide

4.5 NVH
NVH (Noise, Vibration and Harshness) is the study of unwanted movements and sounds
generated by a vehicle. The PicoDiagnostics NVH software can analyze vibrations and help to
diagnose NVH problems. All you need is a PicoScope Automotive oscilloscope and a Pico NVH
diagnostic kit.

4.5.1 Setup tab

If you have cancelled the PicoScope NVH Analyzer Setup Wizard but an NVH test is
required, the Wizard can be restarted by clicking the NVH button, or by choosing NVH from
the Tests menu.

As an alternative to using the Wizard, you can enter settings manually in the Setup page as
follows:
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4.5.1.1 RPM signal

You need to select an RPM Signal source. You can choose between:

· J2534 / J1939 / ELM327 scan tool
· Square Wave / Tach
· Static RPM

J2534 / J1939 / ELM327 scan tools

a) Plug the ELM327 scan tool into a USB port on the computer.

b) Check that the program recognizes the scan tool.

c) Plug the J2534 / J1939 scan tool into the 16-pin (OBD-II or EOBD) diagnostic socket in the
vehicle.

d) Start the engine and check that the RPM signal is being received.

Square Wave / Tach

For this option you can connect any signal proportional to RPM, such as crankshaft, to either
Channel A of a 2-channel automotive scope or Channel D of a 4-channel automotive scope.

Static RPM

If the vehicle will remain at a static RPM during the test, enter the RPM value here.

4.5.1.2 Vibration signal

The Vibration Signal settings also require confirmation.

Box

Refers to which NVH interface you have connected to the PicoScope oscilloscope (see the label
on the underside of the interface).

Sensor

Used to select the type of sensor connected to the NVH interface.

Orientation

 While this setting makes no difference to the way in which the software
records data, it is a useful feature for specifying the orientation of the
accelerometer during the test.
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Location

 Indicates where the sensor will be placed. If you can feel the vibration when
sitting inside the vehicle, select Passenger compartment. If the software
then identifies the problem vibration as originating from the engine, move the
accelerometer into the engine bay, and select Engine compartment. 

Notes are used to record specific information about the test. The notes will appear as a tooltip
while viewing the bar graph data and hovering over each graph with the mouse pointer. Each
interface box has its own notes area, and each note entry field is limited to 1000 characters.

Mode informs the software of the equipment you have connected to the oscilloscope. The
available choices are Single Channel, 3-axis, 3-axis plus Single Channel, or Multiple
Sensors.

Single channel

This mode is for use with a single-axis accelerometer, a single channel of a 3-axis
accelerometer, and when using a microphone.

3-axis

The 3-axis option from the Mode selection alters the user interface slightly, revealing additional
setup options.

ChA(X) If checked, this instructs the program to record signal data for the X axis.

ChB(Y) If checked, this instructs the program to record signal data for the Y axis.

ChC(Z) If checked, this instructs the program to record signal data for the Z axis.

Note: The Z axis is unavailable if the NVH Interface has been connected to a 2-channel
automotive scope.

3-axis plus single channel

Note: The 3-axis plus Single Channel mode is unavailable if the NVH Interface has been
connected to a 2-channel automotive scope.

The 3-axis plus Single Channel option from the Mode selection alters the user interface slightly,
revealing additional setup options.

ChA(X) If checked, this instructs the program to record signal data for the X (fore/aft) axis.

ChB(Y) If checked, this instructs the program to record signal data for the Y (vertical) axis.

ChC(Z) If checked, this instructs the program to record signal data for the Z (lateral) axis.

channel D (X, Y or Z) This is an additional axis. You can add either a microphone or you can
add a single channel of a 3-axis accelerometer, and select between X (fore/aft) axis, the Y
(vertical) axis or the Z (lateral) axis.

Multiple sensors

The Multiple sensors option from the Mode selection alters the user interface slightly,
revealing additional setup options. You can have any combination of accelerometer axis inputs
or microphones using multiple sensor mode. You must inform the software of how many
interface boxes you have attached to your PicoScope oscilloscope, and specify the type of
sensor attached to each. The number of interfaces connected can be adjusted in the box next
to the Mode option, and can have the value of 2, 3 or 4.
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Signal quality check

The Vibration Signal on the Setup tab includes a green signal quality bar. Here you are able to
check that the software is registering the signal from the accelerometer or microphone. Tap
the accelerometer with your finger and check that a pulse is shown on the signal bar:

No vibration: Vibration detected:
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4.5.1.3 Signal Options

Use this to set the desired capture time, which can be from 50 to 500 seconds. 

Note: Increasing the capture time can significantly increase the file size.

This box is not displayed on the setup screen by default. You can change this by ticking the
Enable Advanced Options box in the Advanced Options dialog.

4.5.2 Vehicle information

Under the Vehicle Information tab,
select the vehicle's drivetrain
configuration.

There is an added feature for managing
and using Parameter IDs (PIDs). Click the
Configure PIDs button to use it. 

4.5.2.1 Advanced button

Select the Advanced button to enter more
specific vehicle details.
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4.5.2.2 Configure PIDs button

“Graphing PIDs” or in full “Graphing OBD-II parameter identification codes” are standardized
codes sent via a scan tool to the relevant vehicle network to request specific data. The SAE
standard J1979 defines several PIDs, but many more PIDs are specified by the respective
vehicle manufacturers. Typically, technicians use PIDs with a scan tool connected to the
vehicle's OBD-II connector.

The PID is sent to the vehicle's controller-area network, a device on the bus recognizes the
PID and reports the value for it back to the bus, from which it is sent to the scan tool and
displayed to the technician.

Note: You can only view the values from the PIDs in the Time Domain view on the record and
analyze tab.

The NVH software utilize these PIDs to request engine and road speed data via the J2534 OBD
interface (MongoosePro ISO/CAN 2). 

Both engine and road speed are graphed in the signal history in order to identify the vehicle
condition under a variety of noise and vibration symptoms. You can request a number of OBD-II
parameters using available PIDs stored in the PID library in PicoDiagnostics NVH.

To access the PID library click on the Vehicle Information tab and select Configure PIDs
where Available PIDs can be selected then added to the Current Capturing PIDs table.

The Configure PIDs dialog includes two lists,
along with several functions. The first list is
called Available PID Library. This list
contains PIDs that you can select to capture,
edit, delete or export. The second list is the
Current Capturing PIDs, which shows you
the PIDs in use and their current values. 

When you select one or more PIDs from the
Available PID Library list you have the
option to click on the Start Capturing
button. By clicking this button you move the
selected PIDs to the Current Capturing PIDs
list and will be able to read the values.
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If you want to remove PIDs from the Current
Capturing PIDs list you select them and click
the now active Stop Capturing button, which
will move them back to the library list. 

Note: "Engine speed" and "Vehicle speed"
are active by default, and cannot be removed.

You can export PIDs as .pdpid files by selecting
one or more PIDs from the Available PID
Library list and clicking on Export. You will
then be asked if you want to export only the
selected files or the entire Library, before you
select the directory to save to.

You can import exported .pdpid files to add to
the Available PID Library list.

You can create new PIDs by clicking the
Create button. You will then see the Create
PID dialog box. Enter the PID (hex) along with
its description formula and unit. Click OK to
create the PID.
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4.5.3 Record and analyze page

To begin the test:

Click the Start Recording button: 

The time chart at the bottom of the screen will show the signal from the accelerometer. Start
the engine. 

Note: If the vibration can be felt while the vehicle is stationary then the test can be done in
the workshop. Otherwise, a road test will be necessary.

Run the road test or workshop test while PicoDiagnostics captures data from the vehicle. You
will see data appearing in the signal history window at the bottom of the screen. This chart
also shows RPM, road speed and gear selection (only visible if transmission ratios have been
entered under the Advanced button of the Vehicle Information tab) for the duration of the

test.

When the test is finished, click the Stop Recording button: 

To reset the current capture and clear any recorded data while retaining the test settings,

click the Reset Current Capture button: .

4.5.4 Viewing the results

For the clearest results, select the region of the test where the vibration was at its strongest.
Do this by dragging the mouse over the time chart from the beginning to the end of the region
of interest.

You can view the results in a number of ways. Click on the view button for the view you wish
to display:
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4.5.4.1 Frequency graph

The Frequency graph displays the relevant spectrum for the sensor in use. The accelerometer,
for example, has a default value of 0-350 Hz but you can change this in the Advanced
Options.

In the example below, the main vibration detected is clearly identified as an E2 (second order
engine vibration). An E2 vibration is quite normal with a 4 cylinder 4 stroke engine, as the
crankshaft is subjected to two firing events every revolution. (Twice the fundamental
frequency of the engine, E1). The accelerometer will detect the level of E2 vibration and
display the amplitude in “mg” units in the frequency graph. Each individual axis of a 3-axis
accelerometer can be displayed by selecting Display Mode and Single by right-clicking on the
frequency graph. Each axis is represented by a different color and its respective amplitude
indicated along the Y-axis. 

An excessive amount of E2 could indicate a problem with engine mounts or the "contact"
between the engine and the chassis.

By default the Frequency display (FFT) window requires a minimum of 2.5 seconds of continual
disturbance to process the event. The FFT window is configurable on the Advanced Options,
FFT tab (accuracy vs responsiveness slider).
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4.5.4.2 RPM Order graph

By selecting RPM Order you will see the
frequency display converted to indicate
vibration levels relevant to engine
speed/frequency. The RPM order display is
now scaled in multiples of the fundamental
engine speed (E1) allowing the NVH software
to track and display engine vibration orders in
a fixed position regardless of engine speed.
This is particularly useful should you wish to
monitor engine vibration orders at varying
engine speeds and loads. The images highlight
the effects on an E2 (second order engine)
vibration from a four stroke four cylinder
engine under acceleration (Figure 1)
deceleration (Figure 2) and cruising
(Figure 3). 

During acceleration (Figure 1: 3146 rpm) the
crankshaft loading will increase due to driver
demand (high E2). Under deceleration the
opposite will occur (Figure 2: 1725 rpm)
where fuel is cut during over-run and
crankshaft combustion load is removed
(minimal E2). When cruising (Figure 3: 1748
rpm), fueling and combustion are present but
with reduced load upon the crankshaft (low
E2). 

Referring to all the images of the RPM order,
the positions of the E1 and E2 markers remain
fixed throughout the entire engine speed /
frequency range, and the scale indicates
partial, or multiples of, engine vibration orders
assisting with clear identification of offending
engine vibrations. 

 

Figure 1

Figure 2

Figure 3
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4.5.4.3 Road Speed graph

In this graph, frequencies are scaled to road speed, so wheel and axle-related harmonics
appear at fixed positions regardless of road speed. This makes it easier to spot propshaft and
wheel-related vibrations during a road test.
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4.5.4.4 Bar graph

This view lists all the selected vibration harmonics and shows their values in real time. Below,
Unknown Vibration (U) peaks have been enabled under Add Vibration. 

With 3-axis plus single channel and Multiple sensors you have the option of adding a
microphone as a sensor. When you add a microphone, the Bar Graph view in Record and
Analyze will change to show the measurement dB as well as a different color on the bar
compared to the vibration bars. 

Single Channel 3-axis Vector Sum (default view)

3-axis (single view) 3-axis plus single channel (single view)

3-axis plus single channel (in default view) Multiple sensors
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4.5.4.5 3D Frequency graph

The 3D frequency graph creates a record of how the vibration spectrum changes over time
during a test drive. Selected vibrations are plotted as colored path allowing you to monitor the
change in frequency of a specific vibration over time. Such a feature assists with the detection
and measurement of resonance that is present for a brief moment in time when a forced
vibration matches the natural frequency of a component (for instance the exhaust resonance
at a specific engine RPM). The axes can be dragged to change the vertical and horizontal
scales along with the viewing angles.
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4.5.4.6 Time Domain

Time Domain is a real time feature you can use to measure harshness, such as knocks, creaks
and squeaks. Noises and harshness like these are annoying but are only present for a very
short period of time, with insufficient energy to be transferred to and displayed in the
Frequency display (FFT) of the NVH user interface. The time domain feature will capture and
display the momentary amplitude of these noises.

Events (e.g. pothole strikes) are captured in the signal history as it displays the input of the
attached microphone or accelerometer live (relative to time). These events are not transferred
for display in the FFT as it requires a a certain amount of time with continual disturbance in
order to process the event. 

Until now, symptoms like these would be reserved for listening devices, letting the technician
listen to the intensity of noises delivered to a headset from microphones placed around the
offending area of the vehicle. The results, however, would be subjective and open to
misinterpretation.

For instance: 

Given the vehicle chassis is a single structure, any momentary noise is dissipated throughout
the chassis where it can be detected at strategic points about the chassis by accelerometers
or microphones. 

The accelerometer/mic adjacent to the knock will detect the highest amplitude and the
accelerometer/Mic furthest away from the knock will detect the event but at a reduced
amplitude. 

The Time Domain display gives the technician the ability to detect the source of a momentary
knock, squeak, creak or click, despite their presence only being felt/heard for just a split
second.
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Left: Note that the Time Domain view is the only
view that displays the data from capturing PIDs.

4.5.4.7 Graph features

General features

Drag left or right on the Frequency, Road Speed or RPM
Order graphs to position the order markers. The markers
are automatically positioned at the fundamental frequency
and its harmonics.

Drag the vertical and frequency axis up and down to
change the vertical scale.

Drag the box at the bottom of each frequency ruler to
move the ruler.

Right-click on any graph to reveal the context menu:

Scale To Fit. Only available in Time Domain. You can use
this as an auto scale, to adjust the axes to fit on screen
if the signal displays outside the edges.

Link Scales. Only available in Time Domain. This function
is to keep all of the axes proportional throughout the
capture to be able to do a relative comparison.

Display PID Configuration. When this is enabled the PID
will be displayed with the PID ID (hex) and the formula. 

Auto Scale. This will enlarge or reduce the vertical scale
to make the signal fit on the graph.

Reset scale. Resets the scale view to default.

Reference Waveforms. Available in Frequency view, use
this function to add previously saved data as a reference.

Channels In View. Lets you display/hide individual
channels of data from the scope.

PIDs In View. Available in Time Domain view. Lets you
display/hide individual PIDs from the screen.
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Display Mode. See below:

Vector Sum. Only available when 3-axis mode or 3-axis
plus single channel has been selected. Displays the
magnitude of the vector sum of all three axes.

Single. Displays the amplitude of each of the selected
channels in View individually.

Peak. Shows the highest amplitude of the selected
channels in View.

Average. Averages the amplitude of all the selected
channels in View.

Only available when 3-axis or 3-axis plus single
channel modes have been selected, these buttons
switch between Vector Sum and Single display modes
(see above).

Clicking this accesses the Details information screen.

Clicking this button will preview the report ready for
printing.

Click any vibration marker for more information.

Use this button to show or hide specific vibration orders
on each graph.

Right-click on the recorded data in the signal history at
any time to reveal the context menu:

Place Signal Marker. This will place a signal marker at
the point the right-click was made, regardless of the time
delay between the right and left mouse button clicks.

Remove Marker. Right-click on a previously placed signal
marker to reveal the context menu. This option will
remove the marker at the point the right-click was made.

Export Selected Region To CSV. This will save a CSV file
containing all the vibration data that is currently within
the selected region of recorded data.

Export Selected Region to WAV. This will save a WAV
file containing all the audio data that is currently within
the selected region of recorded data.
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These buttons are used to:

Place Signal Marker. This button is only available while recording
data, and is used to add a signal marker at the currently recorded data
point.

Scroll through signal markers. These buttons are used to scroll
backwards or forwards through placed signal markers. Only available
once recording has been completed.

Vibration order markers

In the various frequency graphs, vibration orders are marked with labels such as “T1” and “E2”.
The letter indicates the type of vibration: 

• E = Engine
• T = Tires
• P = Propshaft
• U = Unknown
• AP = AC pump pulley
• A = Alternator pulley
• PS = Power steering pulley
• W = Water pump pulley

The number is the order of vibration. For example, “E2” is the second-order engine-related
vibration.

Click on any marker in PicoDiagnostics for more information.
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4.5.5 Options

Location: Options on the menu bar

Note: some of the commands shown below might not be available unless the Enable Advanced
Options box is ticked in the Advanced Options dialog.

Save Settings. PicoDiagnostics will remember any changes you made to the program settings
and use them next time you run the program.

Advanced Options. Opens the Advanced Options dialog, which controls the signal
processing algorithms used by PicoDiagnostics.

Calibrate. Opens the Calibration Wizard. Only available for single and 3-axis mode.

Load Audio Files. Opens the Load Audio dialog for using a WAV format audio file instead of
using the microphone.

Function Generator. Opens the Function Generator dialog.
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4.5.6 Advanced options

Location: Options on menu bar, then Advanced Options.

The tabs contains various options related to frequency spectrum calculations. While these are
detailed below, we suggest you do not adjust them (unless recommended to do so by your
Technical Support department).

4.5.6.1 Graph

Maximum frequency of
interest

Maximum frequency that will be displayed with the FFT views.

Frequency Units Adjusts the unit of measure along the X axis in the FFT views
(RPM/Hz/CPM).

SPL Weighting Allows you to adjust the weighting for Sound pressure level (SPL).
The available options are: dB(A), dB(B), dB(C), and dB(SPL).

Harmonic Marker Count Lets you choose the number of harmonic markers to use on the
capture.

Accelerometer units Lets you choose the scale. The dBg is a logarithmic scale, g is a

linear scale and m/s2 for SI acceleration units.
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4.5.6.2 FFT

Windowing Lets you select one of the standard window functions for spectrum
analysis. The available options are: Hann, Rectangular, and Flat-
top.

FFT Bin Count Adjust points of FFT sacrificing processing time.

Responsiveness Allows you to adjust the length of the scan time. Reducing the scan
time reduces resolution of frequency in the FFT.

4.5.6.3 Filter

Note: Filtering occurs post-capture and has no effect on the recording of live data.
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Low pass Allows any frequency below the set threshold to be detected.

High pass Allows any frequency above the set threshold to be detected.

Band Pass When enabled allows frequencies between the low pass and
high pass range to be detected.

Band Stop When enabled allows frequencies outside of the low pass and
high pass range to be detected.

4.5.6.4 Features

Enable Advanced Features Some commands under the main Options menu are hidden
unless this box is ticked.

Enable Wizard By default this option is enabled. To stop the NVH Wizard from
appearing uncheck this box.

Calculate Road Speed Enable this to calculate the road speed through the gear ratios
in order to derive the tire and propshaft vibrations. This can be
used instead of gaining the vehicle speed via the OBD port.
Note: If a square wave/tach is used for RPM signal, this option
is on by default.

Enable OBD Logging Adds additional information to the trace file (for Technical
Support).

4.5.7 Load audio dialog

Location: Options > Load Audio File on the menu bar

This dialog is only available when the Enable Advanced Options box is ticked in the
Advanced Options dialog.

By using this dialog you can analyze previously recorded audio, for example of vehicle noise
recorded by a customer. The file must be in WAV format.
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1. Click Load and locate the audio file.
2. Verify that the Sound Properties are correctly shown.
3. If desired, click Play to listen to the file.
4. To convert the file for vibration analysis in PicoDiagnostics, click Create Signal.

4.5.8 Function generator

The inbuilt Function Generator can generate sounds by using your laptop to stimulate
resonance, causing an object to vibrate with a greater amplitude at its specific natural
frequency. This means that the technicians can listen to audio played back at specific
frequencies and match it to sounds present in the vehicle. 

The feature can be manipulated to play back audio through the vehicle’s In Car Entertainment
system (ICE) via the PC headphone socket, streamed from the PC via Bluetooth, or FM
modulator if the vehicle does not have Aux or Bluetooth.

This is a very useful feature when customers complain about interior rattles. They will often
have difficulty describing the sound or pinpointing the origin. If you playback variable low
frequencies via the ICE with the Function Generator, and increase the volume, you can
generate rattles inside the cabin that can be confirmed by the customer and help the
technician find the origin. All safely done in a parked car.
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Source There are several different sources to choose between: Fixed frequency, T1,
T2, T3, E1, E2, P1 and P2

You can output fixed frequencies through the speakers and compare them to
the vibrations heard during a road test, or you can select other frequency
sources to output to a strobe light (third-party hardware) to identify faulty
components.

Frequency Frequency to use when creating the playback sound. Use the arrow buttons to
adjust it up or down.

Wave Type Sine wave is used to replicate frequency vibrations through the speakers.
Square wave is used for controlling a strobe light function.

Hz bar You can also adjust the frequency by dragging the blue button right or left on
the bar. This is useful if you do not know frequency, as you can drag this back
and forth while playing the sound to hear the difference and use for matching.

Mute button Click the loudspeaker icon next to the Hz bar to toggle the sound on and off.

Sweep Mode Enable sweep mode. In sweep mode you can sweep up or down between the
start frequency and the end frequency at a specified sweep time.

Sweep
Down

Makes the function generator sweep from the high frequency to the low
frequency.

Sweep Up Makes the function generator sweep from the low frequency to the high
frequency.

Pause Temporarily stops the sweep.

Resume Starts the sweep again from where you paused it.

Start
Frequency

The lowest frequency you want to sweep to/from

End
Frequency

The highest frequency you want to sweep to/from

Sweep Time The time you want to do the sweep in.
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